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Chapter 857

Confidence Intervals
for Michaelis-Menten
Parameters
Introduction
This routine calculates the sample size necessary to achieve specified widths of the confidence intervals of the
parameters of the Michaelis-Menten equation at a stated confidence level. The analysis assumes that the
parameters are estimated using maximum likelihood and that the error variance is proportional to the independent
variable.
Caution: This procedure assumes that parameter estimates of the future sample will be the same as planning
estimates that are specified. If actual estimates are very different from those specified when running this
procedure, the interval width may be narrower or wider than specified.

Technical Details
Michaelis-Menten Equation
The formulas used here are found in Raaijmakers (1987). The Michaelis-Menten equation is a well-known model
of enzyme kinetics. It is a special arrangement of a two-parameter rectangular hyperbola. The mathematical
model is
C(Vmax)
C + Km
where V is the dependent variable, C is the independent variable, and Vmax and Km are parameters to be
estimated. In enzyme kinetics, V is the velocity (rate) of an enzyme reaction and C is the substrate concentration.
Vmax and Km have simple physical interpretations. Vmax is the maximum velocity and serves as a horizontal
asymptote. Km is the value of C the results a velocity of Vmax/2. It is known as the Michaelis constant or ED50.
𝑉𝑉 =

Estimation
Although several methods have been proposed to estimate the parameters of the Michaelis-Menten equation from
a set of data consisting of concentrations and corresponding rates, we will use the method of maximum likelihood
because it leads to simple, analytical formulae for the parameters as well as large-sample confidence intervals.
The nonlinear regression model associated with this equation is
𝑉𝑉 =

C(Vmax)
+ 𝜀𝜀
C + Km
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where ε represents normally distributed errors with zero mean and variance 𝜎𝜎 2 . However, this assumption of a
constant absolute error is not appropriate in most situations. It is usually more appropriate to assume that σ is
proportional to the mean value at each value of C. This leads to the following statistical model
𝑉𝑉 =

C(Vmax)
C(Vmax)
+�
� 𝜀𝜀
C + Km
C + Km

If we let X equal V/C, Raaijmakers (1987) provided the following estimates of the parameters and their variances.
� =V
� + Km
� 𝑋𝑋�
Vmax

� =
Km

𝑋𝑋�𝑆𝑆𝑉𝑉𝑉𝑉 − 𝑉𝑉� 𝑆𝑆𝑋𝑋𝑋𝑋
𝑉𝑉� 𝑆𝑆𝑋𝑋𝑋𝑋 − 𝑋𝑋�𝑆𝑆𝑋𝑋𝑋𝑋

� and X − �
where SVV, SXV, and SXX are the sum of squares and cross products of the deviations V − V
X. �V and �
X are
the sample means of the corresponding variables.
An unbiased estimate of the error variance is given by
σ2 =
�
where N is the sample size.

� 𝑆𝑆𝑋𝑋𝑋𝑋 + 𝐾𝐾𝐾𝐾
� 2 𝑆𝑆𝑋𝑋𝑋𝑋
𝑆𝑆𝑉𝑉𝑉𝑉 + 2𝐾𝐾𝐾𝐾
𝑁𝑁 − 2

The large-sample variances of these estimates are given by
��≈
var�𝐾𝐾𝐾𝐾
where

𝜎𝜎 2
� 2 � ∑𝑁𝑁 (𝑈𝑈𝑖𝑖 − 𝑈𝑈
�)2
�1 + 2𝜎𝜎 2 /𝑉𝑉𝑉𝑉𝑉𝑉𝑉𝑉
𝑖𝑖=1

� �≈
var�𝑉𝑉𝑉𝑉𝑉𝑉𝑉𝑉
𝑈𝑈𝑖𝑖 =

𝜎𝜎 2
� 2 var�𝐾𝐾𝐾𝐾
��
+ 𝑈𝑈
𝑁𝑁

Vmax
C𝑖𝑖 + Km

Finally, confidence intervals can be calculated for these estimates based on the normality of the estimates. The
100(1 – α)% confidence interval for Km is
� ± z1−𝛼𝛼/2 �var(𝐾𝐾𝐾𝐾)
𝐾𝐾𝐾𝐾

The 100(1 – α)% confidence interval for Vmax is

� �
� ± z1−𝛼𝛼/2 �var�𝑉𝑉𝑉𝑉𝑉𝑉𝑉𝑉
𝑉𝑉𝑉𝑉𝑉𝑉𝑉𝑉

The widths of these intervals are easily determined.

A close inspection of these formulas will show that they depend on the experimental design. That is, the C values.
So the sample size formulae require the specification of a specific design.

Confidence Level
The confidence level, 1 – α, has the following interpretation. If thousands of samples of n items are drawn from a
population using simple random sampling and a confidence interval is calculated for each sample, the proportion
of those intervals that will include the true population slope is 1 – α.
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Procedure Options
This section describes the options that are specific to this procedure. These are located on the Design tab. For
more information about the options of other tabs, go to the Procedure Window chapter.

Design Tab
The Design tab contains most of the parameters and options that you will be concerned with.

Solve For
This option specifies the parameter to be solved for from the other parameters.

Confidence
Confidence Level (1 – Alpha)
The confidence level, 1 – α, has the following interpretation. If thousands of samples of N items are drawn from a
population using simple random sampling and a confidence interval is calculated for each sample, the proportion
of those intervals that will include the true population slope is 1 – α.
Often, the values 0.95 or 0.99 are used. You can enter single values or a range of values such as 0.90, 0.95 or 0.90
to 0.99 by 0.01.

Number of C Values and Sample Size Allocation
Number of Unique C Values
Select the number of C values in the experimental design. This is the number of unique values of the independent
(C) variable. The actual C values are entered in the Experimental Design section below. The possible range of
values for this option is 2 to 20.
Since this model includes curvature, at least three C values are needed. We recommend at least five C values to
allow a more detailed examination of the nature of the curvature.
Allocation of N to C Values (Solve For = Confidence Interval)
Select the method used to allocate subjects to the various C values. The choices are
Equal sample sizes for all C values (n = n1 = n2 = ...)
The sample sizes allocated to each C value are the same. The value of n, the number of subjects at each unique C
value, is entered in the n (Sample Size for All C Values) box below.
Enter base sample size and multipliers for each C value
The sample sizes at each unique C value are found by multiplying the corresponding Multiplier value (found in
the Experimental Design section) times the Base Sample Size value entered in the box below.
Enter total sample size and a percentage for each C value
The sample sizes at each unique C value are found by taking the corresponding percentage found in the
Experimental Design section of the N (Total Sample Size) value entered below.
Enter an individual sample size for each C value
Enter the sample size at each C value directly in the corresponding Sample Size box found in the Experimental
Design section below.
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Allocation of N to C Values (Solve For = Sample Size)
Select the method used to allocate subjects to the various C values. The choices are
Equal sample sizes for all C values (n = n1 = n2 = ...)
The sample sizes allocated to each C value are the same. The optimum total sample size will be found using a
binary-search algorithm.
Enter sample size multipliers for each C value
The sample sizes at each unique C value are found by multiplying the corresponding Multiplier value (found in
the Experimental Design section) times a base sample size value that will be searched for using a binary-search
algorithm.
Using this option, you can search for a sample size configuration in which the individual sample sizes are not all
equal.
Enter a sample size percentage for each C value
The sample sizes at each unique C value are found by taking the corresponding percentage (found in the
Experimental Design section) of the N (Total Sample Size) value that will be searched for using a binary-search
algorithm.
This options allows you to search for a sample size configuration in which the sample sizes at each C value are
not equal.
n (Sample Size for All C Values)
Enter the sample size to be used for all C values. The total sample size, N, is the number of C values times this
value. The range is one to several thousand. At a minimum, you should have at least two subjects at each C value
so that you can measure the pure error variance.
You can enter a single value, such as ‘5’, a list of values, such as ‘2 5 10 50’, or a series of values, such as ‘2 to 20
by 2’. A separate line on the numeric report is generated for each value specified here.
Base Sample Size
This is the base sample size for each C value. One or more values, separated by blanks or commas, may be
entered. A separate analysis is performed for each value listed here.
The individual samples sizes at each C value are determined by multiplying this value by the corresponding
Multiplier value entered in the Experimental Design section. If the Multiplier numbers are represented by
m1, m2, m3, ...
and this value is represented by B, the individual sample sizes are calculated as follows:
n1 = [B(m1)]
n2 = [B(m2)]
n3 = [B(m3)]
where the operator, [X] means the next integer after X, e.g. [3.1]=4.
For example, suppose there are three groups and the multipliers are set to 1, 2, and 3. If B is 5, the resulting
sample sizes will be 5, 10, and 15.
N (Total Sample Size)
This is the total sample size of all C values. One or more values, separated by blanks or commas, may be entered.
A separate analysis is performed for each value listed here.
The individual samples sizes at each C value are determined by multiplying this value times the corresponding
Percent of N value entered in the Experimental Design section. If the Percent values are represented by
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p1, p2, p3, ...
and this value is represented by N, the individual sample sizes are calculated as follows:
n1 = [N(p1/100)]
n2 = [N(p2/100)]
n3 = [N(p3/100)]
where the operator, [X] means the next integer after X, e.g. [3.1]=4. If this operation results in a total sample size
different from N, various individual sample sizes are reduced or increased by one until the total is N. The change
is made to the sample size that is most different from its intended value.
For example, suppose there are three C values and the percentages are set to 25, 25, and 50. If N is 36, the
resulting sample sizes will be 9, 9, and 18.

Parameters
Vmax (Maximal Velocity)
Vmax is a parameter of the Michaelis-Menten equation that represents the maximum reaction velocity (rate). It
serves as a horizontal asymptote. It is determined from considering previous studies, a pilot study, or an educated
guess. It is in the scale of the dependent variable (reaction rate of velocity).
You may enter a single value or multiple values. The values must be greater than zero.
Enter the maximum that you think the dependent variable (velocity or rate) can be.
Vmax Confidence Interval Width
Enter the is the desired width of the confidence interval of Vmax. A binary search will be conducted to find the
minimum sample size that will result in this width or narrower.
You may enter a single value or multiple values.
Km (Michaelis Constant)
Km is a parameter of the Michael-Menten equation often called the Michaelis constant or ED50. It is in the same
scale as the C values. In fact, Km is that C value that results in a velocity of Vmax/2.
You may enter a single value or multiple values. All values should be positive.
Km Confidence Interval Width
Enter the desired width of the confidence interval of Km. A binary search will be conducted to find the minimum
sample size that will result in this width or narrower.
You may enter a single value or multiple values.
σ (Error Standard Deviation)
Enter the anticipated value of the standard deviation of the errors. This value is usually found from a previous
experiment or a pilot study. It is in the scale of the velocity (reaction rate).
You may enter a single value or multiple values.
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Experiment Design (C Values and Sample Size Allocation
C Value
Enter a single C value. This is the anticipated value of the independent variable (substrate concentration) at this
position. The experimental design is specified by giving these C values along with the sample size at each point.
Multiplier
The sample size allocation Multiplier at this C value is entered here.
If Solve For is equal to C.I. Width, the individual sample sizes for each C value are found by multiplying this
value by the Base Sample Size value and rounding up to the next whole number.
If Solve For is equal to Sample Size, the individual sample sizes are found by multiplying this value by the base
sample size that is being searched for and rounding up to the next whole number.
Typical values of this parameter are 0.5, 1, or 2.
Percent of N
This is the percentage of the total sample size, N, that is allocated to this C value. The individual samples sizes are
determined by multiplying this value times the N (Total Sample Size) value entered above (if Solve For = CI
Widths) or the trial value of N (if Solve For = Sample Size).
If these values are represented by
p1, p2, p3, ...
the sample sizes are calculated as follows:
n1 = [N(p1/100)]
n2 = [N(p2/100)]
n3 = [N(p3/100)]
where the operator, [X] means the next integer after X, e.g. [3.1]=4.
For example, suppose there are three C values and these percentages are set to 25, 25, and 50. If N is 36, the
resulting sample sizes will be 9, 9, and 18.
Sample Size
Enter the individual sample size corresponding to this C value. This allows you to enter the individual sample
sizes directly.
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Example 1 – Calculating Sample Size
Suppose a study is planned in which a researcher wishes to construct 95% confidence intervals for Vmax and Km.
Previous studies have found Vmax to range from 20 to 30 and Km to be about 10. The confidence level is set at
0.95. The standard deviation of the residuals estimate, based on the MSE from a similar study, ranges from 10 to
40. The sample size needs to be large enough so that the width of the Vmax confidence interval is 5.
The design is to set the number of C values to 5. The individual C values are 1, 4, 16, 64, and 256.

Setup
This section presents the values of each of the parameters needed to run this example. First, from the PASS Home
window, load the Confidence Intervals for Michaelis-Menten Parameters procedure window by clicking on
Regression, and then clicking on Confidence Intervals for Michaelis-Menten Parameters. You may then make
the appropriate entries as listed below, or open Example 1 by going to the File menu and choosing Open
Example Template.
Option

Value

Design Tab
Solve For ................................................ Sample Size using Vmax
Confidence Level .................................... 0.95
Number of Unique C Values ................... 5
Allocation of N to C Values ..................... Equal sample sizes for all C values (n = n1 = n2 = …)
Vmax (Maximal Velocity) ........................ 20 30
Vmax Confidence Interval Width ............ 5
Km (Michaelis Constant) ........................ 10
σ (Error Standard Deviation) .................. 10 20 30 40
C1 ........................................................... 1
C2 ........................................................... 4
C3 ........................................................... 16
C4 ........................................................... 64
C5 ........................................................... 256

Annotated Output
Click the Calculate button to perform the calculations and generate the following output.

Numeric Results
Numeric Results
C Values: 1, 4, 16, 64, 256

Conf
Row Level
1
0.950
2
0.950
3
0.950
4
0.950
5
0.950
6
0.950
7
0.950
8
0.950

Total
Sample
Size
N
135
390
730
1175
150
470
875
1355

SD of
Errors
σ
10.000
20.000
30.000
40.000
10.000
20.000
30.000
40.000

Maximal
Velocity
Vmax
20.000
20.000
20.000
20.000
30.000
30.000
30.000
30.000

SE(Vmax)
1.261
1.270
1.272
1.274
1.267
1.275
1.272
1.275

Vmax
CI Width
4.943
4.979
4.987
4.992
4.965
4.998
4.986
4.999

Michaelis
Constant
Km
10.000
10.000
10.000
10.000
10.000
10.000
10.000
10.000

Km
SE(Km) CI Width
1.056
4.141
0.879
3.445
0.712
2.790
0.585
2.292
0.740
2.901
0.673
2.637
0.587
2.300
0.510
2.000
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Michaelis-Menten Equation with Variance Proportional to Substrate Concentration
Model: V = (Vmax C) / (Km + C) + (Vmax C) / (Km + C) ε
Dependent variable: V, the reaction rate (velocity).
Independent variable: C, the substrate concentration.
Error variable: ε, the residual. The model assumes that ε ~ N(0 σ²).
Report Definitions
Confidence Level is the proportion of confidence intervals (constructed with this same confidence level) that
would contain the true value of the estimated parameters: Vmax or Km.
N is the total sample size of the experiment.
σ is standard deviation of ε when (Vmax C) / (Km + C) = 1.
Vmax is a planning estimate of the maximum reaction rate (V).
SD(Vmax) is the standard error of the maximum likelihood estimate of Vmax.
Vmax CI Width is the width of the confidence interval of Vmax.
Km is a planning estimate of the Michaelis constant. This is the C value that yields a V of Vmax/2. It is
sometimes called ED50.
SD(Km) is the standard error of the maximum likelihood estimate of Km.
Km CI Width is the width of the confidence interval of Km.
Summary Statements
A sample size of 135 subjects results in a width of 4.943 for a two-sided, 95% confidence
interval of Vmax and a width of 4.141 for a two-sided, 95% confidence interval of Km. The
planning estimates are 20.000 for Vmax, 10.000 for Km, and 10.000 for σ. The experiment design
is sample sizes of 27, 27, 27, 27, 27 corresponding to S values of 1, 4, 16, 64, 256.

This report shows the calculated sample size for each of the scenarios.
Design Details for Row 1
C Level
C1
C2
C3
C4
C5

C
1.0
4.0
16.0
64.0
256.0

n
27
27
27
27
27

Pct of N
20.0
20.0
20.0
20.0
20.0

This report shows how the 135 subject are allocated to the various C values. In this case, 27 subjects are allocated
to each of the five C values.
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Plots Section

These plots show how the necessary sample size changes for variance values of the error standard deviation and
Vmax.
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Example 2 – Validation using Raaijmakers
Raaijmakers (1987) page 798 gives an in which a researcher wishes to construct 95% confidence intervals for
Vmax and Km. The design is to set the number of C values to 5. The individual C values are 1, 4, 16, 64, and 256.
Previous studies have found Vmax be 25 and Km to be 10. The confidence level is set at 0.95. The standard
deviation of the residuals is estimated at 6.25. The sample sizes of 5, 10, and 20 result in SE(Vmax) values of
4.444, 3.143, and 2.222 and SE(Km) of 3.169, 2.241, and 1.585. The confidence interval widths are easily
calculated from these standard errors.

Setup
This section presents the values of each of the parameters needed to run this example. First, from the PASS Home
window, load the Confidence Intervals for Michaelis-Menten Parameters procedure window by clicking on
Regression, and then clicking on Confidence Intervals for Michaelis-Menten Parameters. You may then make
the appropriate entries as listed below, or open Example 2 by going to the File menu and choosing Open
Example Template.
Option

Value

Design Tab
Solve For ................................................ CI Widths of Vmax and Km
Confidence Level .................................... 0.95
Number of Unique C Values ................... 5
Allocation of N to C Values ..................... Equal sample sizes for all C values (n = n1 = n2 = …)
N (Sample Size for All C Values) ............ 1 2 4
Vmax (Maximal Velocity) ........................ 25
Km (Michaelis Constant) ........................ 10
σ (Error Standard Deviation) .................. 6.25
C1 ........................................................... 1
C2 ........................................................... 4
C3 ........................................................... 16
C4 ........................................................... 64
C5 ........................................................... 256

Output
Click the Calculate button to perform the calculations and generate the following output.

Numeric Results
Numeric Results
C Values: 1, 4, 16, 64, 256

Conf
Row Level
1
0.950
2
0.950
3
0.950

Total
Sample
Size
N
5
10
20

SD of
Errors
σ
6.250
6.250
6.250

Maximal
Velocity
Vmax
25.000
25.000
25.000

SE(Vmax)
4.444
3.143
2.222

Vmax
CI Width
17.422
12.319
8.711

Michaelis
Constant
Km
10.000
10.000
10.000

Km
SE(Km) CI Width
3.169
12.423
2.241
8.784
1.585
6.211

PASS matches these standard errors exactly. Note that the confidence interval width is 4.444 x 1.96 x 2 = 17.42
which matches PASS’s result within rounding.
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